
Loans management 

Thanks to the loans management module, BiblioMaker offers the possibility to record 
loans, reservations, check in and loan renewals. 

This document describes how to record these different transactions. It is intended for the 
persons in charge of these tasks. However, the software settings for loan management are 
not covered here; a more complete explanation can be found in the reference manual. 

Contents 

1. Access to the loan management window 2 ..............................................................
1.1 The window 2 ...........................................................................................................................................

1.2  Menus 3 

1.3 Entering status 3 ......................................................................................................................................

1.4 Identifying a reader 4 .............................................................................................................................

1.5 Identifying a title 4 ..................................................................................................................................

2. Registering loans 5 ...............................................................................................................

3. Registering returns 6 ............................................................................................................

4. Registering renewals 7 ........................................................................................................

5. Registering reservations 8 ..................................................................................................
5.1 Registering a reservation 8 ....................................................................................................................

5.2 Warning when the reserved title returns 8 ........................................................................................

5.3 Loaning a reserved title 8 ......................................................................................................................

6. Registering an internal traffic 9 ........................................................................................

7. Printing 10 ................................................................................................................................
7.1 Loans list 10 ..............................................................................................................................................

7.2 Loans list on ticket 10 .............................................................................................................................

7.3 Labels with reader address 10 ..............................................................................................................

7.4 Labels with title barcode 10 ..................................................................................................................

7.5 Subscription letter 10 ..............................................................................................................................

8. Cashing in 11 ...........................................................................................................................
8.1 Cashing in a fine for overdue loans 11 ...............................................................................................

8.2 Cashing in for other reasons 12...........................................................................................................

BiblioMaker : loans management Page 1



1. Access to the loan management window 
When the software starts, it automatically displays the last file that was opened when you 
left the software: Titles, Addresses, Loans, etc. The first operation therefore consists in 
displaying the Loans file via the Data>Loans menu. 

To access the Loan Management window, then choose Action>New or click the New 
button in the button bar at the top of the main window. 

1.1 The window 

The loan management window allows you to perform all the transactions recording 
operations with the readers, such as the loan, reservation, return, loan renewal, cashing in, 
printing the reader account status, etc. In general, this window remains permanently open 
at the lending desk during library opening hours. 

The window contains several zones : 

  

Entry zone 

In this zone, you identify the reader and the titles and you check the current entering 
status (Loan / Reservation / Renewal / Remove-Return / Internal traffic). 

Messages zone 

This zone displays several warnings such as overdue loans, open due amount, expired 
subscription, etc. 

Reader zone 

This zone displays information about the current reader. 

Titles zone 

This zone displays loans and reservations for the current reader. 

Selection zone 

This zone displays further information about the title selected in the titles zone. 
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Buttons zone 

This zone contains several buttons for renewing or removing loans/reservations or cashing 
in. 

1.2  Menus 

The loan management window is accompanied by two menus offering various commands. 

The File menu essentially allows you to print the reader's account status on an A4 page or 
on a ticket (if you have a receipt printer). 

The Entry menu contains commands to change the entering status and tell the software 
what your next actions will be: recording loans, reservations, renewals, returns, internal 
traffic. It also allows you to search titles, modify title or reader records, recall one of the last 
readers for which you made a transaction or view their history of loans. 

1.3 Entering status 

The Entering status is displayed in the upper right corner of the loan management 
window. This status is very important as it influences the processing of the title you identify 
in the Entry code field. 

The Loan entering status indicates that the titles you will identify will be considered 
borrowed. 

The Remove-Return status indicates that the titles you will identify will by considered 
returned or - if in case of a reservation - the reservation cancelled. 

The Reservation entering status indicates that the titles you will identify will be 
considered reserved. 

The Internal traffic entering status indicates that the titles you will identify will be 
considered borrowed in Internal traffic mode. You will find at § 6 an explanation about this 
entering status. 

The Renewal entering status indicates that the loans you will identify will be renewed. 

You can change the entering status in three different ways : 

A) With help of the mouse, choose another status in the Entry menu. 

B) With help of the keyboard, enter one of the shortcuts displayed on the right-hand side 
of the Entry menu. 

C) Use the Barcode status reference list you have printed and scan one of its barcodes. 

If you choose the wrong entering status, the software would not understand what you 
want to do and could display error messages or do the wrong thing (for instance return a 
title that is still lent). This is why it is important to always check the current entering status. 

You can change the entering status at any time. For instance, you can register the loan of 
titles for a reader with the Loan entering status, then change the Entering status to 
Remove-Return in order to register titles coming back. Doing the same operation in reverse 
order is of course also possible, as usually readers begin with giving titles back before 
taking new titles. Of course, when you change the entering status, it is not necessary to 
identify a reader again if his account is already displayed. 
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1.4 Identifying a reader 

During some operations ( loan, reservation, internal traffic), you must begin with the reader 
identification. Several methods are available for doing it : 

A) If the reader has a library card with a barcode, just scan it. 

  

B) Without a library card, enter in the Entry code 
field the "/" character followed by the reader 
name/surname (for instance /smith ; the beginning 
of the name could be enough), then start the search by pressing the Tab key. 
If the software finds only one reader, his name is automatically displayed in the Reader 
zone. If several readers have been found, a window for selecting the reader is 
displayed. 

Once the reader has been identified, the next step is usually to identify the titles. 

1.5 Identifying a title 

A title can be identified in several ways : 

A) If the title has a barcode (on a label or the ISBN printed on the back), scan it. 
 

  

B) In the Entry code field, enter a search 
criterion : words from the title after the "\" 
character (for instance \harry potter), record 
number after the "#" character (for instance #1234), then start the search by pressing 
the Tab key. 

C) In the Entry menu, call the Find title or Search title command and define the search 
criterion : Title, Number, Shelf mark, etc. and start the search. 

If the software finds only one title, it is automatically displayed in the titles zone. If several 
titles have been found, a window for selecting the title is displayed. 

If the goal is to renew a loan or to delete a reservation, a title can be identified by selecting 
it with the mouse in the titles zone, after the corresponding reader has been identified. 
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2. Registering loans 
Registering loans happens as follows : 

1) Check that the Entering status is Loans, otherwise select it in the Entry menu (see § 
1.3). 

2) Identify the reader with his barcode or his name (see § 1.4 Identifying the reader), 
unless his account is already displayed. 

3) Identify the title with its barcode or by doing a search (see § 1.5 Identifying a title).  
If the reader borrows several titles, repeat this step for each title. 

Each title identified is added to the titles zone table. The table displays the date of the loan, 
the title, the expected date of return and in the Operations performed column the 
mention Loan. 

Once you have finished with a reader, you can click on the Validate button or immediately 
identify the next reader without clicking on Validate : when switching reader, the 
operations performed with the current reader are automatically saved. 
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3. Registering returns 
Registering the return of titles can happen in two ways : 

Identifying the reader and selecting titles with the mouse : 

1) Identify the reader with his barcode or his name (see § 1.4 Identifying the reader), 
unless his account is already displayed. 

2) Select in the titles zone the title to return, then click on the Delete button. 
Repeat this step with other titles from the same reader. 

Tip : if you press the Alt key when clicking on the Delete button, all titles lent by this 
reader will be returned. This shortcut can nevertheless be dangerous, because you have to 
be sure that all titles have physically been returned, what can be difficult to check if the 
reader has borrowed many titles. 

Identifying titles directly with the scanner : 

1) Check that the Entering status is Remove-Return, otherwise select it in the Entry 
menu (see § 1.3). 

2) Identify the title with its barcode or by doing a search (see § 1.5 Identifying a title).  
If the reader gives several titles back, repeat this step for each title. 

Each title identified stays in the titles zone table with the Remove-Return mention in the 
Operations performed column. Nevertheless, the Number of loans field below the loans 
table is updated in order to mirror the reader account status. 

Once you have finished with a reader, you can click on the Validate button or immediately 
identify the next reader without clicking on Validate : when switching reader, the 
operations performed with the current reader are automatically saved. 

  

If overdue titles have been returned and your library bills a fine, a due amount is displayed 
below the table in the titles zone. When validating loans, a dialog box can be displayed, 
demanding the payment of the fine. This dialog box is described at § 8 (Cashing in). 
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4. Registering renewals 
Registering renewals happens in two possible ways : 

Identifying the reader and selecting with the mouse titles to renew : 

1) Identify the reader with his barcode or his name (see § 1.4 Identifying the reader), 
unless his account is already displayed. 

2) Select in the titles zone the loan to renew, then click on the Renew button. A dialog 
box is displayed, suggesting a renewal duration and a new date of return. If you agree 
with the suggestion, validate the dialog box, otherwise change either the renewal 
duration or the new date of return before validating. 
Repeat this step with other titles from the same reader.  

Tip : if you press the Alt key when clicking on the Renew buttton, all loans for this reader 
will be renewed : the renewal dialog box will be displayed for each title to renew. 

Identifying titles directly with the scanner : 

1) Check that the Entering status is Renewal, otherwise select it in the Entry menu (see 
§ 1.3). 

2) Identify the title with its barcode or by doing a search (see § 1.5 Identifying a title). A 
dialog box is displayed, suggesting a renewal duration and a new date of return. If you 
agree with the suggestion, validate the dialog box, otherwise change either the 
renewal duration or the new date of return before validating. 
Repeat this step with other titles from the same reader. 

Notice : if the title to renew has been reserved in the meantime by another reader, the 
software warns you and it's up to you to decide if you allow the renewal of the loan. 

Each title identified stays in the titles zone table with the Renewal mention in the 
Operations performed column. 

Once you have finished with a reader, you can click on the Validate button or immediately 
identify the next reader without clicking on Validate : when switching reader, the 
operations performed with the current reader are automatically saved. 
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5. Registering reservations 
Managing reservations happens in three steps : registering the reservation for the second 
reader, registering the title return for the first reader and finally registering the loan for the 
second reader. 

5.1 Registering a reservation 

1) Check that the Entering status is Reservation, otherwise select it in the Entry menu 
(see § 1.3). 

2) Identify the reader with his barcode or his name (see § 1.4 Identifying the reader), 
unless his account is already displayed. 

3) Identify the title by doing a search (see § 1.5 Identifying a title). If the title to reserve is 
available, you will be informed of it. 
If the reader wants to reserve several titles, repeat this step for each title. 

Each title identified is added to the titles zone table. The table displays the date of the loan, 
the title, the expected date of return and in the Operations performed column the 
mention Reservation. 

Once you have finished with a reader, you can click on the Validate button or immediately 
identify the next reader without clicking on Validate : when switching reader, the 
operations performed with the current reader are automatically saved. 

The next step usually happens several days or weeks after this first step. 

5.2 Warning when the reserved title returns 

When a reader brings back a title reserved by another reader, you register the return as 
usual (see § 3). The system warns you during this operation that the title has been reserved, 
in order to prevent you from putting the title back to the shelf. You just have to validate the 
warning. 

The next step usually happens several days after the second step. 

5.3 Loaning a reserved title 

When a reader who has reserved a title comes to the library, you can identify him as usual 
(see § 1.4 Identifying a reader). In the titles zone, the reserved title is accompanied by the 
Available mention in the Information column. If several readers have reserved the same 
title, the Available label is followed by two numbers giving the priority order for the 
reservation. For instance, Available (2/3) means that the reader is the second out of three in 
the reservation queue. The system gives the priority to the first reader who has reserved. 

The operations for registering the loan of a reserved title are the same ones as described at 
§ 2 Registering loans. The only difference with a standard loan is that the reservation record 
is converted into a loan record in the titles zone. 
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6. Registering an internal traffic 
An internal traffic is very similar to a loan. The only difference is that when generating 
reminders, internal traffic records are skipped. Internal traffic is a loan without any date of 
return. 

Internal traffic can be used in the following situations : 

Loan for a reader you don't want to send a reminder to (for instance the librarians or a 
teacher in a school) 

Temporary exclusion of a title from the circulation. For instance, in order to repair a 
damaged title or to exhibit it, you could loan the title to a fictive reader called "Repair" 
or "Library". By doing so, the title will be displayed as "not available" in the catalogue. 

You register an internal traffic in a way that is very similar to a loan : 

1) Check that the Entering status is Internal Traffic, otherwise select it in the Entry menu 
(see § 1.3). 

2) Identify the reader with his barcode or his name (see § 1.4 Identifying the reader), 
unless his account is already displayed. 

3) Identify the title with its barcode or by doing a search (see § 1.5 Identifying a title).  
If the reader borrows several titles, repeat this step for each title. 

Each title identified is added to the titles zone table. The table displays the date of the loan, 
the title and in the Operations performed column the mention Internal Traffic. 

Once you have finished with a reader, you can click on the Validate button or immediately 
identify the next reader without clicking on Validate : when switching reader, the 
operations performed with the current reader are automatically saved. 
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7. Printing 
When managing loans, you can print at any time one of the following print templates by 
calling the File>Print command : 

7.1 Loans list 

List of loans on an A4 page. 

7.2 Loans list on ticket 

List of loans on a ticket (this option is available only if a slip printer has been configured in 
the software). 

7.3 Labels with reader address 

Reader address printed on a label. This print template is useful if you send loans to a 
reader's home 

7.4 Labels with title barcode 

Barcode label for the selected title. This print template is useful should you notice that the 
barcode label is damaged. 

7.5 Subscription letter 

Letter inviting the reader to pay his subscription. 
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8. Cashing in 
When managing loans, you can have to cash in fines for overdue loans, reader 
subscriptions or for any other reason (for instance title damaged or lost). You can register 
the cashing in. 

8.1 Cashing in a fine for overdue loans 

If the software has been configured for calculating fines for overdue loans or reminder fees, 
a due amount is automatically displayed below the table in the titles zone. 

  

If you register the return of a title, when validating loans, you get a dialog box displaying 
the due amount : 

  

If the reader pays the due amount, the cashed amount will have the same amount. In this 
case, you can enter a value in the Payment method and Label fields. 

But if the reader is not able to pay the due amount, you can choose between cashing in a 
smaller amount (and the remainder will be discounted) or cash in nothing (the Cashed 
amount will be 0). In this last case, you can decide to cash in the next time the reader 
comes to the library or fully cancel if you tick the Discount the remainder check box. 

If the cashed amount is 0 and the Discount the remainder check box is not ticked, an alert 
is displayed in the messages zone the next time you identify the reader, so that you don't 
forget to cash in the due amount. 

If the reader pays the due amount, you can print a slip. Validate the payment with the OK 
button. 
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8.2 Cashing in for other reasons 

You can register the cashing in from the loans management by clicking on the Payment 
button. A dialog box is displayed and you can choose the payment reason : 

  

After you have selected the reason, validate with OK. A second dialog box is displayed : 
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Enter the needed information in the fields. If you cash in the due amount, enter it in the 
Cashed amount field. If you cash in only a part of the due amount, enter it also in the 
Cashed amount. The Discount the remainder check box is automatically ticked, as you 
will not be able to demand the remainder to be paid later on. 

If necessary, enter a value in the Cause, Label, Payment method, Voucher Nr. and Cash 
register code fields before validating.
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